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DataMan 200 Systems
IDQuick™ High-
Speed Decoding

Moving Part 
Applications

IDMax™ Degraded 
DPM Reading 

DataMan 200S 
(DMR-200S-00)

√

DataMan 200Q 
(DMR-200Q-00)

√ √

DataMan 200X 
(DMR-200X-00)

√ √ √

DataMan 200 Accessories

CD-ROM 
(Setup Tool and Drivers)
(206-6400-330)

Quick Reference Guide 
(590-7097)

Mounting bracket  
(DM100-UBRK-000)

Ethernet M12 to RJ45 cable 
(CCB-84901-1003-xx)

Liquid Lens Module 
(DM200-LLM-000)

I/O cable 
(CCB-M8IO-xx)

RS-232 cables 
(CCB-M8X4-xx)

AC Power over Ethernet (PoE) Adapter 
(CPS-AC-POE1A-xx)

24V Power over Ethernet (PoE) DIN-RAIL Mount Adapter 
(CPS-24V-POE1)

Red lens cover (ESD-safe)  
(DM100-RLC-000)

Clear lens cover (ESD-safe) 
(DM100-CLC-000)

Direct part mark illumination kit 
(DM100-DPML-000)

Harsh Environment Enclosure 
(DM100-HENCL-00)

Pivot Mounting Bracket 
(DM100-PIVOTM-00)
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Reader Layout

Pushbutton

Push to read• 

Push and hold 3 • 

seconds to train

Use Setup Tool to • 

program additional 
button functions

Setting the Focus Position
DataMan can operate in one of three distance ranges. To set the focus 
position: 

Set focus position.

Tighten screws in order 
shown. Maximum torque for 
the cover screws is 9 N-cm 
(0.79 pound-inch).

Disconnect 
DataMan 
from power 
before 
adjusting 
focus

Illumination LEDs

Laser apertures 
(aiming)

Ethernet

RS-232

I/O

Mounting holes 
(M3 X 5)System

Yellow: Power• 
Green: Ethernet connected• 
Blink: Communication • 
(RS232, Ethernet or both)

User

Yellow: Untrained• 
Green: Trained• 
Blinking: Trigger• 

Status

Green (pulse): Read• 
Red (pulse): No read• 
Red/Green (long pulse): Train • 
or Optimize Focus result

2.

Remove screws and 
lens cover.

1.

Replace lens cover 
and screws.

3.

1
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Mounting the Reader

Mount the reader at 
a slight angle (15°) 
to reduce reflections 
and improve reader 
performance.

Horizontal field of view for the DataMan 200 at working distances of 40mm, 
65mm and 105mm

Disconnect DataMan from power 
before removing or changing cables

Ethernet and RS-232 Connections

You must connect your reader to your PC to establish the 
parameters your reader will use as it operates. Connect the 
reader using both the Ethernet and an RS-232 connection:

Ethernet

RS-232 PoE adapter

In

Out

Using an RS-232 connection can be necessary to configure the reader 
with parameters that allow it to communicate over your Ethernet 
network.  

Or Ethernet only: 

M12 to RJ45

Ethernet

PoE adapter

In

Out

M12 to RJ45
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Reading Distances

Supported range of reading distances for four code sizes (6, 8, 10, and 12 mil) 
at each of the three focus positions (40mm, 65mm, and 105mm).



RS-232 connection
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Install DataMan 200 Software Troubleshooting an Ethernet Connection

Make sure your PC meets these system requirements:1. 

Microsoft® Windows™ XP SP3 or Windows Vista• 
Pentium CPU 1 GHz• 
.NET 2.0 (installed automatically) • 

Insert CD-ROM and follow the on-screen prompts.2. 

Connect the DataMan 200 to your PC. 3. 

Launch the Setup Tool and click 4. Refresh.

The reader will appear under COM ports, Network devices, or both.

Select a 5. COM port listing or Network devices listing and click Connect. 

Ethernet connection

“DM200_” with last 6 
characters of MAC address, 
printed on back of the 
reader

Based on your network configuration, the Setup Tool may not be 
able to communicate with the reader and it will not appear in the list 
of Network devices. 

First check your Ethernet connection with the reader and click 
Refresh in the Setup Tool. Next, scan the Enable DHCP code in 
the DM200 Configuration Codes document available from the Start 
menu. This might allow the reader to acquire a suitable IP address 
from a DHCP server on your subnet. 

If the reader still does not appear, you can use either the Add 
Device or Force Network Settings options in the Setup Tool. 

If you know the IP address of the reader, use the Add Device 
option. If you do not know the IP address, use the Force Network 
Settings options. Either method should allow the DataMan 200 
reader to appear in the list of Network devices so that you can 
connect to it through the Setup Tool and your Ethernet connection. 
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Start the Setup Tool

Connect to Reader

Establish a connection to the reader

Results Display

View results

Light and Camera Settings

Choose a trigger type and other acquisition 
parameters

System Settings

Configure input and output signals

Trigger button Latest image Context based help

Read history Train status Connection status
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Use the Setup Tool General Toolbar

File Menu

Open Configuration Open a saved .cfg configuration file. 

Save Configuration Create a .cfg configuration file of current run-
time parameters. 

Restore Device Load a saved device configuration .cdc file, 
with run-time parameters plus device-specific 
information for a particular DataMan 200. 

Backup Device Create a device configuration .cdc file for a 
specific reader. 

Print Configuration Code Not supported on the DataMan 200.

Save Image Save the latest acquired image with the .jpg or 
.bmp file format.

System Menu

Save Settings Save the current parameters to non-volatile 
memory, which allows the reader to restore 
these settings each time you reboot it.

Reset Configuration Reset all configuration parameters in RAM 
(volatile memory) to the default settings. 

Update Firmware Update the reader software.

Upload Feature Key Unlock additional features available in the 
reader software if you have the right key.

VeriCode License Add VeriCode decoding by entering a license 
string provided by Veritek. Ask your Cognex 
sales representative for details. 

Each reader can store its current set of run-time parameters to a configuration 
(.cfg) file, which contains information such as the enabled symbologies and 
how any output data should be formatted. 

The same configuration file can be loaded onto multiple readers, as the file 
does not contain identification information such as the IP address or device 
name of the reader used to create it.

A reader can also generate a Cognex device configuration (.cdc) file, which 
stores the set of run-time parameters plus any identification data, such as 
the name of the device, its IP address, subnet mask, and so on. Cognex 
recommends generating a device configuration file for each reader to allow you 
to restore a DataMan 200 to its operating state with minimal effort. 

Use the File menu of the Setup Tool to manage .cfg and .cdc files: 

Save Burst Images Save the latest batch of burst images.

Exit Exit the Setup Tool

Use the Edit menu for standard Cut, Copy and Paste operations. 

Use the View menu to view reader information (serial number, firmware 
version, and so on) and to enable and disable various elements of the 
Setup Tool, and the Tasks menu to switch between various Setup Tool 
options. 

Use the System menu to manage the current settings on the reader 
and to upgrade the features it currently supports: 

Use the Help menu to display Setup Tool version information. 
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DataMan 200 Triggering Trigger Modes

Trigger the reader using any of the following methods: 

Press the trigger button on the reader.• 

Send a pulse on the I/O cable:• 

Trigger + (blue), Trigger - (black)

Send a trigger command over the RS-• 
232 connection or Ethernet connection.

Click the Trigger button in the Setup • 
Tool:

Press <CTRL>-T on the keyboard. • 

DataMan supports a variety of trigger modes: 

Single: Acquires a single image and attempts to decode any symbol • 
it contains, or more than one symbol in cases where multicode is 
enabled. The reader relies on an external trigger source. 

Presentation: Repeatedly scans for a symbol and decodes it • 
whenever one is detected. The reader relies on an internal timing 
mechanism to acquire images. 

Manual (default): Begins acquiring images when you press the • 
trigger button on the reader, and continues acquiring images until a 
symbol is found and decoded or you release the button. 

Burst: Performs multiple image acquisitions based on a single • 
external trigger and decodes any symbol appearing in a single image 
or within a sequence of images, or multiple symbols in a single 
image or within the sequence of images when multicode is enabled. 
You can control the number of images within each burst and the 
interval between image acquisitions.

Self: Similar to Presentation mode in that the reader perpetually • 
scans for symbols and decodes them each time one is detected. 
Unlike Presentation mode, however, Self mode supports multicode 
results and a decode attempt occurs with every image.

Continuous: Begins acquiring images based on a single external • 
trigger and continues to acquire images until a symbol is found 
and decoded, or more than one symbol in the same image when 
multicode is enabled. 
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Training the Reader

Training your reader with the expected symbology can decrease the time 
required to decode successive symbols. Train your reader by placing a code 
in front of it and doing one of the following: 

Press and hold the trigger button for a • 
minimum of 3 seconds. 

Click and hold the trigger button in • 
the Setup Tool for a minimum of 3 
seconds. 

Click • Train Code in the Results Display pane. 

Training is supported for the Single, Burst, Continuous and Self trigger 
modes. 

Connect the reader to the Setup Tool to 
untrain it and allow it to recognize other 
enabled symbologies. 

Training Feedback

The middle LED on the reader glows green to indicate that it is currently 
trained, or yellow to indicate that it is not trained.

Incremental Training for Multiple Symbologies

If you want to train the reader to recognize multiple symbologies, you 
can present a single image showing all the desired symbologies and 
perform the training procedure previously described. 

If you cannot present a single image showing all the necessary 
symbologies, you can enable incremental training on the Training tab 
of the Symbology Settings pane: 

With incremental training enabled, you can train the reader using 
multiple images showing the symbologies you expect to decode. The 
reader will train each new symbology while retaining the existing 
trained symbologies.  
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I/O Cable

Pin # Signal Name Wire Color

1 High Speed Out 0 Brown

2 High Speed Out 1 White

3 Trigger + Blue

4 Trigger - Black

5 Common Out Grey

1

2

5

3

4

The I/O cable provides access to trigger and high-speed outputs. 

Unused bare wires can be clipped short or tied back using a tie made of non-
conductive material. 

Acquisition Triggering

The acquisition trigger input on the reader is opto-isolated. To trigger 
from an NPN (pull-down) type photo-detector or PLC output, connect 
TRG+ to +24V and connect TRG– to the output of the detector. When 
the output turns on, it pulls TRG– down to 0V, turning the opto-coupler 
on. 

To trigger from an PNP (pull-up) photo-detector or PLC output, connect 
TRG+ to the output of the detector and connect TRG– to 0V. When the 
output turns on, it pulls TRG+ up to 24V, turning the opto-coupler ON. 
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High-Speed Output Lines

The high-speed outputs can be used as either NPN (pull-down) or PNP (pull-up) 
lines. For NPN lines, the external load should be connected between the output 
and the positive supply voltage (<28V). The outputs pull down to less than 3V 
when ON, which causes current to flow through the load. When the outputs are 
OFF, no current flows through the load. 

Controller Opto-isolators

NPN Out

Out Common

Specification Description

Voltage 28V maximum through external load

Current 50mA maximum sink current

OFF state leakage current 100µA

External load resistance 240 Ohms to 10K Ohms

Each line rated at a maximum 50mA, protected against 
over-current, short circuits and transients from switching 
inductive loads. High current inductive loads require 
external protection diode. 

PTC 
Fuse

For PNP lines, the external load should be connected between the output 
and the negative supply voltage (0V). When connected to a 24VDC 
power supply, the outputs pull up greater than 21V when ON, and 
current flows through the load. When the outputs are OFF, no current 
flows through the load.  

Out 
Common

NPN Out

Controller Opto-isolators

PTC 
Fuse
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High Speed Output Wiring

GND 
24VDC

Common

Load 
(Coil, Relay...) 
Not to exceed 
100mA

High Speed Out 0

To connect the high-speed outputs to a relay, LED or similar load, 
connect the negative side of the load to the output and the positive side 
to +24V. When the output switches on, the negative side of the load 
is pulled down to less than 3V, and 24 appears across the load. Use a 
protection diode for a large inductive load, with the anode connected to 
the output and the cathode connected to +24V. 

To connect to an NPN-compatible PLC input, connect Output 0 or Output 1 
directly to the PLC input. When enabled, the output pulls the PLC input down to 
less than 3V. 

GND 
24VDC

Common High Speed Out 0

NPN PLC

NPN Compatible Input 
GND 
24VDC

To connect to a PNP-compatible PLC input, connect Output 0 or Output 1 
directly to the PLC input. When enabled, the output pulls the PLC input up to 
greater than 21V. 

GND 
24VDC

Common High Speed Out 0

PNP PLC

PNP Compatible Input 
GND 
24VDC
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RS-232 Cable

The RS-232 cable provides an optional connection between the reader and 
your PC. 

2 4
RxD

3
GND

TxD

1
IN_2

3 RxD
2 TxD

5 GND

235

IN_2

GND 
(RS-232)

2.74K

2.74k

1.0K

+3.3V

10K

28V Max. Across input pins - Transition approx. 12V (Min)

Weight 125 g

Operating Temperature 0ºC — 40ºC (32ºF — 104ºF)

Storage Temperature -10ºC — 60ºC (-14ºF — 140ºF)

Maximum Humidity 95% (non-condensing)

Environmental IP65 (with cable or protection cap attached to all three 
connectors)

Vibration EN61373 including IEC 60068-2-6,60068-2-64 6.4, 
and 60068-2-27

Codes Data MatrixTM (IDMax: ECC 0, 50, 80, 100, 140, and 
200; IDQuick: ECC200)

Vericode (optional)
QR Code and microQR Code

UPC/EAN/JAN
Codabar, Interleaved 2 of 5, Code 39, Code 128, 

and Code 93, Pharma, Postal, RSS/CS, PDF 417, 
MicroPDF 417

Discrete I/O operating 
limits

Trigger, HS Output 
0,1

Max output current: 50 mA @ 24 
VDC 
Output load: 500 Ω @ 24 VDC
Input voltage limits: - 25 VDC — 
+25 VDC

Power Supply 
Requirements

PoE adapter Class 1 or 48VDC
2.0W Max LPS

DataMan 200 Specifications
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PC
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You can connect multiple DataMan 200 readers to a single PC (or other device 
equipped with a serial port) using a multi-port connection. 

A multi-port connection creates a daisy-chain of readers. Each reader receives 
serial data from the previous reader and transmits it to the next reader. When 
a reader transmits data, it is passed through each of the readers in the chain 
between it and the PC. 

Because of the large number of possible configurations, Cognex does not 
supply cabling for multi-port DataMan 200 connections. Instead, you must 
construct your own cable that meets the requirements of your system 
configuration.

The cable must provide a DB-9 connector for each DataMan 200 serial 
cable and a DB-9 connector for the PC serial port. Each DB-9 connector 
must provide Tx Data, Rx Data, and ground. The Tx Data and Rx Data 
pins on adjacent connectors must be connected to provide the multi-
port connection. 

The following diagram shows how to create a multi-port cable for a 
3-reader system:

Multi-Port Connections
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Configuring for Multi-Port Operation

You must connect the Setup tool to each DataMan 200 in turn and enable 
multi-port operation. Click the Communication Settings task and check the 
Enable Multi-Port (RS-232 Sharing) check box.

There is no guaranteed delivery order when multiple readers transmit data 
using a multi-port connection; read results may arrive at the PC in any order. 
You can configure each DataMan 200 reader in a multi-port connection to add 
identifying data to each read result. Your PC application can then determine 
which reader produced a specific read result.

To do this, click on the Data Formatting task, check the Standard 
Formatting Enabled box (for each symbology that you are using), and enter 
text in the Leading Text field. (You can also add trailing text by entering text 
in the Trailing Text field.)

You can obtain the best results when using multi-port connections by 
keeping the following usage guidelines in mind as you design your 
system:

The maximum cable length between any two DataMan readers or • 
between the PC and any DataMan reader should be no greater than 
15 meters.
There is no fixed limit to the number of DataMan readers that you • 
can connect to a single PC. Each reader introduces a delay of about 
100 msec when it retransmits received serial data. If you have 5 
readers, this means that there will be a 400 msec delay between the 
time the first reader in the chain transmits data and the PC receives 
it.
Each DataMan reader must receive a hardware trigger signal on its • 
Input 0 line. You can wire the input ports to a common trigger signal 
or you can provide individual triggers for each reader.
If • any reader in the multi-port chain loses power or becomes 
disconnected, then no data from any other reader will be 
transmitted.
If a DataMan is transmitting its own read result, it will buffer any • 
data received from another reader until it has finished its own data 
transmission. If a DataMan reader is transmitting another reader’s 
data, it will buffer its own data if it receives a trigger signal while it is 
processing the other reader’s data. 
If you use a single power supply for multiple readers, make sure that • 
the power supply can provide enough power for all of the readers.
You cannot connect a reader to the Setup Tool over RS-232 once • 
multiport is enabled. You must first scan the Disable Multi-Port code 
from the Reader Configuration Codes, available from the Start menu. 

Multi-Port Usage Notes
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Liquid Lens Module Installation
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The liquid lens module is an electronically controllable variable focus system. 

Use the Focus Settings pane in the Setup Tool to configure the liquid 
lens for your production environment, which typically supports a reading 
range between 40mm - 250mm. Individual liquid lens modules may 
support a larger range. Contact your Cognex sales representative for 
details. 

4 Slide the supplied 
sleeves down the pins 
on the back of the 
module.

6

Tighten screws in order shown. Maximum torque for the 
cover screws is 9 N-cm (0.79 pound-inch).

Set to 105 mm

Place one or more fingers over the illumination LEDs 
while you remove the focus ring to prevent dislodging 
the internal components of the reader. 
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radio frequency energy and, if not installed and 
used in accordance with the instructions, may 
cause harmful interference to radio communica-
tions. Operation of this equipment in a residential 
area is likely to cause harmful interference, in 
which case the user will be required to correct the 
interference at personal expense.

Canadian Compliance
This Class A digital apparatus complies with 
Canadian ICES-003.
Cet appareil numérique de la classe A est con-
forme à la norme NMB-003 du Canada.

C-Tick Statement

  
Conforms to AS/NZS CISPR 22/ EN 55022 for Class 
A Equipment.

European Compliance

  
The CE mark on the product indicates that the 
system has been tested to and conforms to 
the provisions noted within the 2004/108/EEC 
Electromagnetic Compatibility Directive and the 
2006/95/EEC Low Voltage Directive. 

For further information please contact:
 Cognex Corporation
 One Vision Drive
 Natick, MA 01760
 USA

Cognex Corporation shall not be liable for use 
of our product with equipment (i.e., power 
supplies, personal computers, etc.) that is not 
CE marked and does not comply with the Low 
Voltage Directive.

Laser Safety Statement

Compliance with FDA performance standards 
for laser products except for deviations 
pursuant to Laser Notice No. 50, dated July 
26, 2001.

This device has been tested in accordance 
with IEC60825-1 2nd ed., and has been certi-
fied to be under the limits of a Class 2 Laser 
device.

Use of controls or adjustments or perfor-
mance of procedures other than those speci-
fied herein may result in hazardous radiation 
exposure.

UL and cUL Statement

  
UL and cUL listed: UL60950-1 1st ed. and CSA 
C22.2 No.60950-1 1st ed.

For European Community Users
Cognex complies with Directive 2002/96/EC 
OF THE EUROPEAN PARLIAMENT AND OF THE 
COUNCIL of 27 January 2003 on waste electrical 
and electronic equipment (WEEE).

This product has required the extraction and use 
of natural resources for its production. It may 
contain hazardous substances that could impact 
health and the environment, if not properly 
disposed. 

In order to avoid the dissemination of those sub-
stances in our environment and to diminish the 
pressure on the natural resources, we encourage 
you to use the appropriate take-back systems 
for product disposal. Those systems will reuse or 
recycle most of the materials of the product you 
are disposing in a sound way.

The crossed out wheeled bin symbol informs 
you that the product should not be disposed of 
along with municipal waste and invites you to 
use the appropriate separate take-back systems 
for product disposal.

Compliance Notice 

The DataMan 200 series meets or exceeds the 
requirements of all applicable standards organi-
zations for safe operation. However, as with any 
electrical equipment, the best way to ensure safe 
operation is to operate them according to the 
agency guidelines that follow. Please read these 
guidelines carefully before using your device.

Regulator Specification
USA FCC Part 15, Class A

FDA/CDRH Laser Notice No 50
Canada ICES-003
European 
Community

EN55022:2006 +A1:2007, Class A
EN55024:1998 +A1:2001 +A2: 
2003
EN60950
EN60825-1

Australia C-TICK, AS/NZS CISPR 22 / EN 
55022 for Class A Equipment

Japan J55022, Class A

FCC Class A Compliance Statement

 
This equipment has been tested and found to 
comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC rules. These limits 
are designed to provide reasonable protection 
against harmful interference when the equip-
ment is operated in a commercial environment. 
This equipment generates, uses, and can radiate 
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If you need more information on the collection, reuse, and recycling systems, please contact your local or 
regional waste administration.

You may also contact your supplier for more information on the environmental performance of this product.

i

Warnings and Notices
CAUTION: This device requires the use of an LPS or NEC class 2 power supply.

NOTE: For product support, contact http://support.cognex.com

LASER LIGHT, DO NOT STARE INTO BEAM: CLASS 2 LASER PRODUCT

FAILURE TO FOLLOW THESE INSTRUCTIONS MAY CAUSE SERIOUS 
INJURY

Use of controls or adjustments or performance of procedures other • 
than those specified herein may result in hazardous radiation 
exposure.  
Do not attempt to service or repair this product -- return it to Cognex • 
for service.  
Do not permit anyone other than Cognex Corporation or Cognex-• 
authorized personnel to service, repair, or adjust this product. 
Do not attempt to open or modify this device except as described in • 
this document.
Do not direct or reflect laser light toward people or reflective objects. • 
Do not operate this device if it is damaged or if the covers or seals • 
are missing or damaged. 

This Laser Product is designated as Class 2 during all procedures of 
operation.

Wavelength 650 nm

Laser Power for classification < 1 mW

Beam Diameter < 3mm at aperture

Divergence < 1.5 mrad

For assistance contact Cognex Corporation at http://support.cognex.com

CAUTION: IP protection is ensured only when all connectors are attached to cables 
or shielded by a sealing cap. 
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